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ClearMark Advanced II Printer Quick Start

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this 
equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and 
wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried 
out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application 
of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements 
associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the 
examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in 
this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

The following icon may appear in the text of this document.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

Identifies information that is useful and can help to make a process easier to do or easier to understand.



Table of Contents

Preface
Product Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
About This Publication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Safety Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
General Operating Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Residual Risks When Using the Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Hazards Due to Electricity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Hazards Due to Hot Surfaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Personnel Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Additional Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Chapter 1
Printer Installation Unpack the Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Review the Printer Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Review the Touch Panel Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Install the Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
Extract the Output Tray . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Connect the Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Create a Wired Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Turn the Printer On. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
Turn the Printer Off (Switch the Printer to Standby Mode)  . . . . . . . . . . . . . . . . . . . . . . .  14
Insert an Ink Cartridge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Chapter 2
Software Installation Install the ClearTools Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Install the Printer and Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Connect to a Computer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
USB Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Set Up a Marker Card for the Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Run a Test Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Chapter 3
Operations Insert a Marker Card. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Process a Stack of Marker Cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Print a Marker Card. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Chapter 4
Software-Controlled 
Maintenance

Software-Controlled Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 3



Table of Contents
Notes:
4 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022



Preface

Product Description
The ClearMark™ Advanced II ink-jet printer is a marking system for Bulletin 1492 marker cards. It is used with ClearTools™ software (version 
9.4 or higher).

About This Publication
This publication describes the basic operations that are required to start working with the ClearMark Advanced II printer. Some available 
functions and operations are not described in this publication. See the ClearMark Advanced II Printer User Manual, publication
1492-UM012, to obtain all information that might be needed to operate the device in a proper and safe way.

Be sure to read all safety-related notes before starting to work with the ClearMark Advanced II printer.

For all topics listed in the following list, see the ClearMark Advanced II Printer User Manual, publication 1492-UM012:
• Warranty and liability information
• Copyright
• Handling ink and fluid cartridges
• Symbols and information that is used on the device
• Intended use
• Hazards due to use of incorrect spare parts
• Technical specifications
• Cleaning and maintenance
• Nozzle check
• Troubleshooting
• Longer downtimes
• Other functions

Safety Information

In the following cases, you must disconnect the printer from all sources of power and contact a qualified service technician:
• The power cable or plug is worn or damaged.
• Liquid has entered the printer.
• The printer has fallen, or the enclosure has been damaged.
• The performance of the printer is not up to the required standard, for example, poor print quality or insufficient resistance to 

smearing and scratching.

WARNING: Risk to persons due to electrical and chemical hazards.
• Read the safety and hazard information in this chapter before putting the printer into operation. 
• In addition to the information in this quick start, observe the applicable national work, operating, and safety regulations.
• Observe the applicable internal company regulations.

WARNING: Danger of injury when the printer is open!
Using the printer when it is open can result in cuts and crush injuries.
• Never remove the printer enclosure.
• Components inside the device must be replaced by a Rockwell Automation service technician.

IMPORTANT Device damage!
The printer enclosure must not be removed. Opening the printer results in the loss of any warranty rights.
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 5
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Preface
In addition to observing the preceding warnings, be sure to observe the following guidelines:
• Make sure that all persons who work on the device have fully read and understood the user manual.
• Only use the printer for its intended purpose. For more information, see ClearMark Advanced II Printer User Manual, publication 1492-

UM012.
• Keep all safety information and warnings on the printer clean and legible; replace them, if necessary.
• Only instructed personnel must work on the device.
• To ensure that everyone who uses the device is able to view the user manual at any time, always keep the user manual with the

product for future reference.

General Operating Information
• When selecting the installation site for the printer, ensure that the ambient conditions are suitable. For more information, see the

ClearMark Advanced II Printer User Manual, publication 1492-UM012.
• Make sure that openings in the printer enclosure are not blocked or covered.
• Do not turn off the printer! The printer automatically switches to standby mode. The operating parameters are only retained while the

printer is turned on. These parameters ensure, for example, that the print head is cleaned optimally.
• Keep the ink tank lid closed during operation

Residual Risks When Using the Device
The device has a state-of-the-art design and complies with recognized safety rules and regulations. However, impairments can still arise 
when using the device. Only use the device for its intended purpose. When using the device, observe the warnings on the device and the 
safety information in this quick start. For more information, see the ClearMark Advanced II Printer User Manual, publication 1492-UM012.

Hazards Due to Electricity

Hazards Due to Hot Surfaces

IMPORTANT Use only Rockwell Automation products.
Use only products that are produced or approved by Rockwell Automation (ClearTools marking software, marker 
cards, and ink cartridges).
Poor print quality, printer faults, and damage caused by using unapproved and unsuitable accessories and printing 
materials are excluded from the warranty.

SHOCK HAZARD:  Warning of electrical hazard!
Touching live parts is a direct risk to life. Damage to the insulation or individual components can result in fatal injury.
• Work on the electrical components of the printer must only be carried out by electrical specialists.
• Only connect the device to a properly grounded and fused socket.
• Do not connect the printer to either a switch-operated or a timer-controlled socket.
• Never use damaged power cables.
• Regularly inspect the electrical components of the printer for defects, such as loose connections or damage to the

insulation.
• If damage is detected, immediately switch off the power supply to the printer and have the damage repaired.
• Have all connecting cables and plugs inspected by an electrical specialist at least every 6 months!
• Never bypass fuses and never take them out of operation.
• When replacing fuses, pay attention to the correct amperage.
• When connecting an extension cable to the printer, make sure that the rated current value does not exceed the ampere

rating of the extension cable.
• Keep moisture away from live parts as it can cause short circuits. Pay particular attention to this situation when cleaning the

printer.

WARNING: Burn hazard due to hot surfaces!
Contact with hot components and cards can cause burns. Make sure that all components have cooled to the ambient 
temperature before implementing any service or maintenance work.
6 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022
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Preface
Personnel Requirements
Only trained personnel must operate the printer and perform maintenance tasks. In addition, personnel must also follow the procedures that 
are described in the ClearMark Advanced II Printer User Manual, publication 1492-UM012.

The responsibilities of personnel for commissioning, operating, maintaining, and cleaning must be clearly defined. Personnel require the 
following qualifications for the various activities:

• Trained skilled personnel can do their work and recognize/avoid potential hazards on their own because of their training, knowledge, 
and experience, as well as their familiarity with the relevant regulations.

• Electrical specialists can work independently on electrical devices and recognize/avoid potential hazards because of their training, 
knowledge, and experience, as well as their familiarity with the relevant standards and regulations. Electrical specialists have been 
trained for their specific task and know the relevant standards and regulations.

Additional Resources
These documents contain additional information concerning related products from Rockwell Automation.

You can view or download publications at rok.auto/literature.

For more information about the ClearTools software, please refer to the ClearTools help files.

IMPORTANT Repairs must only be conducted after consultation with Rockwell Automation, and only by an electrical specialist.

Resource Description
ClearMark Advanced II User Manual, publication 1492-UM012.
This document is also available on the DVD disk that is attached to the product.

Provides detailed guidelines for the operation and maintenance of the 
ClearMark Advanced II printer

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1. Provides general guidelines for installing a Rockwell Automation industrial system.

System Security Design Guidelines Reference Manual, publication SECURE-RM001. Provides cybersecurity guidelines for the installation, configuration, and operation of 
industrial control systems.

Product Certifications website, rok.auto/certifications. Provides declarations of conformity, certificates, and other certification details.
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 7
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Chapter 1

Printer Installation

The following sections provide instructions on how to unpack the printer, become familiar with its components, and complete basic 
installation tasks.

Unpack the Printer

Unpack the ClearMark Advanced II printer in the following order:
1. Open the transport packaging.
2. Take out all accessories.
3. Take out the printer.

4. Remove the polystyrene packaging material.

5. Remove the transport restraint (1) from the ink tank lid.

6. Check for any damage.
7. Verify that you have all items that are listed in Table 1.
8. Familiarize yourself with the printer (see Review the Printer Components on page 10 and Review the Touch Panel Components on

page 11).

WARNING: Crush hazard during transport! 
The printer is heavy and must be transported by two people. Always hold the printer at the front and rear when transporting 
it.

IMPORTANT For safety and security reasons, the ClearMark™ Advanced II printer must be located in an area that is only accessible 
by authorized printer users.

IMPORTANT Damage to property!
If the printer is transported improperly, the ink may leak and soil or damage the device. Always transport the printer in 
a horizontal position.

IMPORTANT Two people must lift the printer with the polystyrene packaging material out of the box.

IMPORTANT Keep the original packaging for any future transport.
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 9



Chapter 1          Printer Installation
Review the Printer Components
To become familiar with the printer components, review the following graphics and component descriptions.

Figure 1 - ClearMark Advanced II Printer — Top View

Figure 2 - ClearMark Advanced II Printer — Back View

Figure 3 - ClearMark Advanced II Printer — Ink Tank Compartment

Table 1 - What’s Included

Cat. No. Description Quantity

1492-PCMA2110

ClearMark Advanced II Marking System 1
Power Cables (North American, European + China) 2
Unit/box (5 cards inside) Marker Card, 1492-M5X5 1
Cleaner tissues 1492-PCMACLEANER Ser A, PN-505642 2
Quick start guide 1
DVD with ClearTools™ Software and Documentation (user 
manuals) 1

USB Cable 1

IMPORTANT The ink cartridges are supplied separately and are not installed in the printer. The printer is flushed with fluid.

Item Description
1 Touch panel
2 Ink tank lid
3 Output tray
4 Input tray (loader)
5 Service flap (maintenance through user)

Item Description
1 Connectors
2 Service cover (maintenance through Service staff)

Item Description
1 Ink tank lid (open)
2 Ink cartridges
10 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022



Chapter 1          Printer Installation
Figure 4 - ClearMark Advanced II Printer — Back View Enlarged

Review the Touch Panel Components
The System status main menu displays the status of the printer, which includes information about printer readiness, fill level of the ink 
cartridges and the ink collector, and current print jobs.

Figure 5 - Touch Panel

Table 2 - Icons and Functions in the Main Menu

Icon Name Description

Main menu Expands the symbol view with the names of the main menus.

System status Displays the current printer status: Readiness, fill level of the ink 
cartridges and the ink collector.

Jobs Shows the available submenus: Current jobs, print job history, and 
demo print jobs.

Maintenance Shows the available submenus: Print head cleaning, nozzle check, and 
longer downtime.

Settings Shows the available submenus: Interfaces and advanced settings.

Information Shows the submenu: System information.

Item Description
1 USB-B connector printer/PC
2 Main switch with connection for main plug (115/230 V)
3 Fuse (type: 10 AHT) 
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 11



Chapter 1          Printer Installation
Install the Printer

To install the printer, complete the following steps:
1. Place the printer on a surface that extends beyond the base area of the printer on all sides.
2. Leave enough space in front of the output rail of the printer.
3. Ensure a sufficient supply of air around the printer, as shown in the following illustration.

IMPORTANT Damage to property!
Do not use the printer near potential electromagnetic interference fields, such as speakers or base stations 
of cordless phones. They can negatively affect the correct functionality of the printer.
Place the printer on a flat, stable surface. The printer does not operate properly if it is tilted or at an angle.
Avoid locations where the printer is exposed to great fluctuations in temperature and humidity, direct 
sunlight, strong exposure to light, excessive heat, and high dust levels.
Avoid locations that are subject to impact shocks or vibrations. Avoid transmission of vibrations.

IMPORTANT Observe the necessary operating and maintenance minimum distances.

Item Minimum Space Requirement
1 250 mm (9.84 in.)
2 203 mm (7.99 in.) output rail
3 100 mm (3.94 in.)
4 100 mm (3.94 in.)
5 100 mm (3.94 in.)

Item Device Dimensions

Length 
(excluding 
output  tray)

930 mm (36.61 in.)

590 mm (23.23 in.)
454 mm (17.87 in.)

Width
Height
12 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022



Chapter 1          Printer Installation
Extract the Output Tray
To extract the output tray, complete the following steps:

1. Pull out the output tray (1) until it clicks into place.

2. Fold down the lifting units fully (in two locking steps).

Connect the Printer

Create a Wired Connection
The printer can be connected to the PC via the USB cable. To connect the printer, complete the following steps:

1. Connect the printer to a nearby electrical socket.
2. Make sure that the socket is easily accessible.
3. Make sure that the plugs are fully inserted into the connection socket of the printer and into the socket.
4. Place the cables so that there are no tripping hazards.

SHOCK HAZARD: Warning of electrical hazard!
• Make sure that the main voltage used corresponds to the main voltage indicated on the printer's rating plate.
• Only connect the printer to a properly grounded and separately fused socket.
• Do not connect the printer to either a switch-operated or a timer-controlled socket.
• When using an extension cable, make sure that the rated current value of the printer does not exceed the ampere rating of

the extension cable.
• When connecting the printer to the power supply, make sure that the building installation is protected with an appropriate

fuse.
• Make sure that the power cable is not damaged.
• Leave the power cable in its original condition.
• Do not place any objects on the power cable.
• Make sure that there are no kinks or bending points along the cable.
• Do not pull the plug out of the socket by the cable.

IMPORTANT Do not connect the USB cable until you have installed the ClearTools software.
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 13



Chapter 1          Printer Installation
Turn the Printer On
To turn the printer on, complete the following steps:

1. Press the main switch at the rear of the device (Figure 4 on page 11).
The standby button (1) lights up green, which indicates that:

• The printer is ready for operation.
• The printer has no current print job.

When the standby button is orange, it indicates that:
• The printer is in standby mode.
• The printer is processing a current print job.

Turn the Printer Off (Switch the Printer to Standby Mode)

To switch the printer to standby mode, press the standby button (1) for three seconds.

The standby button lights up orange. Only the print head including the control is now supplied with power. This allows the print head to be 
supplied with ink to help prevent it from drying out.

IMPORTANT Turning off the printer at the main switch on the rear of the device can cause the ink nozzles to clog. Automatic 
cleaning after turning the printer back on again becomes necessary.
• Do not turn off the printer.
• Keep the printer in standby mode.
• If the printer will be out of operation for more than three weeks, set the printer to Longer Downtime mode. For more

information, see the ClearMark Advanced II Printer User Manual, publication 1492-UM012.
14 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022
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Chapter 1          Printer Installation
Insert an Ink Cartridge

Before installation of an ink cartridge, you must be aware of the following information:
• Open the ink cartridge packaging just before inserting the ink cartridge into the printer.
• New ink cartridges are covered with a protective film at the ink outlet. Do not remove this protective film. The protective film is

punctured when the ink cartridge is inserted and remains on the ink cartridge.
• The ink cartridges must not be shaken, disassembled, or refilled.
• Store unopened ink cartridges in a cool and dry location (recommended temperature: 4 °C (39.2 °F)). Before use, the ink cartridges

must be warmed up to room temperature for at least three hours.

To insert an ink cartridge, complete the following steps:
1. Slide the ink tank lid (1) in the direction of the arrow.

2. Remove the four blue protective caps from the ink supply outlets.

3. Place each ink cartridge in the designated position.
Each color has a dedicated installation place in the printer, as shown in the following graphic.

WARNING: Hand injuries may occur due to sharp objects!
Open the ink tank lid carefully to avoid stab injuries.

IMPORTANT Upon delivery, there are no ink cartridges in the printer.

IMPORTANT It is very critical that the blue caps be removed from the ink supply outlets for proper functionality.

Item Description
1 Black ink cartridge
2 Cyan ink cartridge
3 Magenta ink cartridge
4 Yellow ink cartridge

IMPORTANT Never touch the ink supply outlet.
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Chapter 1          Printer Installation
4. Make sure that each ink cartridge clicks into place.

5. When you are finished inserting ink cartridges, close the ink tank lid.
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Chapter 2

Software Installation

Install the ClearTools Software
To install the ClearTools software, complete the following steps:

1. Load the ClearTools software DVD.
2. Click Software.

3. Click ClearTools Software Installation.

The ClearTools™ Release Notes appear.

At this point, you can accept the release notes (I Accept) or exit setup (Exit Setup).
4. To continue the installation process, click I Accept
5. In the ClearTools Setup window, click Next.

IMPORTANT For the ClearMark™ Advanced II printer (1492-PCMA2110), you must use ClearTools™ software, version 9.4 or higher.
Rockwell Automation Publication 1492-QS007A-EN-P - November 2022 17



Chapter 2          Software Installation
6. Accept the terms and click Next.

7. Click Typical.

8. Click Install.

The installation process begins. The system asks if you agree to allow ClearTools to make changes to your device. Details of the 
certificate used to sign the ClearTools Setup are displayed.

9. To complete the installation, click Finish.

The ClearTools software is now installed on your PC.
18 Rockwell Automation Publication 1492-QS007A-EN-P - November 2022



Chapter 2          Software Installation
Install the Printer and Drivers
Installation of the ClearMark Advanced II marking system is done by the ClearTools software. Connecting the printer by USB is described in 
the following steps.

Connect to a Computer

Use a USB cable to connect the printer to your computer after the proper version of the ClearTools software has been installed on your PC.

USB Installation

To connect the printer to a computer via a USB connection, complete the following steps:
1. Start the ClearTools software.
2. From the Tools menu, click Printer Administration>Printer Explorer.

The Printer Explorer window appears. This window also appears just after correct installation of ClearTools.

3. Click Add.
The Printer Model dialog box appears.

4. Click ClearMark Advanced II 1492-PCMA2110/A.
The ClearTools software automatically searches for connected printers.

The same USB connection number must be checked in the printer. See item in printer menu: Settings/ Interfaces / USB connection.

5. Select the required USB port or printer.

OR
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Chapter 2          Software Installation
6. Click Add Selection, and then do one of the following:
a. If no printer was found, click Search Again to restart the search process.
b. If you have connected your printer to your PC for the first time, then you may be required to wait and then repeat the search

process.
c. If a printer was found, select the printer and click Add Selection.
The Printer Explorer dialog box appears.

(a)

7. To change a printer name, click Properties.
The Printer properties dialog box appears.

8. In the Display Name field, type the printer name, and then click OK.
9. To check the connection to the printer, in the Printer Explorer dialog box, select the printer that you want to check, and then click

Test.
If the printer is connected and accessible, the Connection Test dialog box appears and displays the following message.

If the printer is not accessible, for example, if it is turned off, the Connection Test dialog box appears and displays the following 
message.

(a)
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Chapter 2          Software Installation
Set Up a Marker Card for the Printer
To set the correct print position for a marker card, and to compensate for physical changes to it, you must change some settings via the 
ClearTools software.

Marker types may not be their normal size, for example, as a result of the ambient temperature.

To set up a marker card, complete the following steps:
1. From the File menu, select File -> Adjust Marker Type.

The Adjust Marker Type dialog box appears (the dialog box may be different depending on the chosen marker card).

2. Check Automatic Measurement (only CMA II).

3. Under Automatic Measurement (only CMA II), select one of the available options:
- Only measure the first marker
Within a print job, only the first page of each new marker type is measured, as shown in the following graphic.

- Measure all markers
All pages within the print job to the ClearMark Advanced II printer are measured.

4. To determine the settings manually, you must print a marker card.
The marker card must not be cured in the calibration process. The printed marker card can be cleaned with cold water and used
again. For more details, please refer to the ClearTools™ help file.

IMPORTANT The ClearMark™ Advanced II printer automatically measures the markers.
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Chapter 2          Software Installation
Run a Test Print
After you turn on the printer, you can run a print test of a marker card.

To run a print test, complete the following steps:
1. In the Jobs menu, select Demo print jobs.
2. Choose a template that corresponds to the supplied marker card.
3. Insert the marker card into the input tray.
4. Click Print to start the test print.
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Chapter 3

Operations

This chapter describes how to print marker cards.

Before you use the printer, you must be aware of the following information:
• The openings in the printer enclosure must not be blocked or covered.
• Do not insert any objects into openings.
• Make sure that no liquid gets into the printer.
• Do not turn off the printer! The printer automatically switches to standby mode.

The operating parameters are only retained while the printer is turned on. These parameters ensure, for example, that the print head is 
cleaned optimally.

WARNING: Warning of crush hazard!
Do not operate the printer without its enclosure and do not reach through its openings while it is running.

WARNING: Warning of automatic startup!
The printer can start up at any time without warning when a print job is sent over the USB connection.

WARNING: Warning of hot surface!
Contact with hot components of the output magazine and marker cards can cause burns.
• Make sure that all components have cooled down to ambient temperature before conducting any work on the output tray.
• Let the marker cards cool down before removing them from the output tray.

IMPORTANT Using expired ink reduces the print quality and can damage the printer.
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Chapter 3          Operations
Insert a Marker Card
Marker cards can be inserted directly without any pretreatment.

Insert the marker card by ensuring that the side with the closed strip is facing the printer as shown in the following graphic.

Process a Stack of Marker Cards
When you process a stack of marker cards, follow these guidelines:

• Marker cards can only be inserted in stacks.
• You can insert a stack of up to a maximum of 50 marker cards into the input tray.
• The stack must not exceed 50 marker cards.
• Do not mix half and whole marker cards in a stack.
• Insert the stack of marker cards (1) into the input tray (2) in the direction of insertion shown previously.
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Chapter 3          Operations
Print a Marker Card
To print a marker card, complete the following steps:

1. Start the ClearTools™ software.
2. Select the required marker card.
3. Type the text or insert an image or barcode that you want to print.
4. Insert the marker card or the marker card stack.
5. Start printing via the ClearTools software.

You can find further information about printing in the help file for the ClearTools software.
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Chapter 3          Operations
Notes:
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Chapter 4

Software-Controlled Maintenance

The ClearTools™ software allows you to perform several important maintenance tasks.

Software-Controlled Maintenance
The following maintenance work is performed or supported on the touch panel in the Maintenance menu:

• Nozzle check in the Nozzle check submenu.
• Automatic print head cleaning in the Print head cleaning submenu.
• Preparing the printer for longer storage in the Longer downtime submenu.

For information about these procedures, see the ClearMark Advanced II Printer User Manual, publication 1492-UM012.
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Chapter 4          Software-Controlled Maintenance
Notes:
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